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L. Description

The Plexor™ qPCR and gRT-PCR Systems(@<) are compatible with a variety of real-
time PCR instruments. Data from these instruments can be analyzed with one
dedicated software program, the Plexor™ Analysis Software. This manual includes
instructions and thermal cycling conditions specific for use of the Plexor™ qPCR
System, Plexor™ One-Step qRT-PCR System and Plexor™ Two-Step gRT-PCR
System with the Roche LightCycler® 480 System. Instructions are included for
instrument setup, data transfer from the instrument to the Plexor™ Analysis
Software and data analysis.

II.  Plate Preparation and Amplification

Detailed instructions describing assay setup are provided in the Plexor™ gPCR
System Technical Manual #TM262, Plexor™ One-Step qRT-PCR System Technical
Manual #TM263 or Plexor™ Two-Step gRT-PCR System Technical Manual #TM264.

When using the Plexor™ gPCR System for the first time, we recommend
programming the thermal cycling conditions and checking that the instrument is
compatible with the dyes used and is configured for those dyes before assembling
the reactions, so the reactions are not kept on ice for prolonged periods of time. Once
you are familiar with the programming process, the instrument can be programmed
after reaction assembly.

Materials to Be Supplied By the User

*  LightCycler® 480 multiwell reaction plate
e centrifuge compatible with a 96-well plate
*  optical adhesive covers and applicator

1. After the amplification reactions have been assembled, cover the reaction plate
with an optical adhesive cover using the applicator. Centrifuge briefly to collect
contents at the bottom of each well.

Note: Keep the plate on ice during reaction setup and programming of the
thermal cycling conditions.

2. Program the Roche LightCycler® 480 System. The proper thermal cycling
conditions and instructions for programming the instrument are provided in
Section III (generating color compensation files), Section IV (qQPCR and two-step
qRT-PCR assays), Section V (one-step qRT-PCR assays) and Section VI

(genotyping assays).
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III.  Generating Color Compensation Files O

For multiplex assays, a color compensation file (cc object) must be created and P
applied to multicolor data to allow proper interpretation. To generate the color mega
compensation file, labeled Plexor™ primers are used as dye calibrators in an initial
color compensation cycling experiment. The color compensation cycling experiment
contains separate color compensation reactions corresponding to each individual dye
in your multiplex, as well as a blank reaction with no dye. Any subsequent runs
performed with the same dyes and similar cycling conditions can be analyzed using
this color compensation file.

Notes:

*  The Roche LightCycler® 480 instrument should be programmed before
preparing the reagents.

*  The color compensation file can be generated after the experimental run and
applied to the multiplex experiment before final analysis.

o Alist of LightCycler®-compatible dyes is available at:
Wwww.promega.com/plexorresources/

III.A. Thermal Cycling Program for Color Compensation

The thermal cycling program is shown in Table 1. Primers designed using the
Plexor™ Primer Design Software have an annealing temperature of approximately
60°C.

Table 1. Color Compensation Thermal Cycling Program.

Step | Temperature Time | Number of
Cycles
Initial
Denaturation: | 95°C 2 minutes | 1 cycle
Denaturation: 95°C 5 seconds
Annealing and 40 cycles
Extension: 60°C 35 seconds
Denaturation: | 95°C 5seconds | 1 cycle
Melt +
Temperature 50°C to 95°C, 2.5 acquisitions per °C
Curve:
Instrument Cool: | 50°C 30 seconds | 1 cycle
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O 1. Open the LightCycler® 480 software.

2. To create a new dye set detection format, select “Tools” in the startup

l’rmega screen. The detection format specifies the channels in which fluorescence
will be read.

Datobase: My Computer (Tracuable)

Window: |o.mam E| [ Sysum Admin

-8 LightCycler® 480 Software release 1.2.0.0625
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3. Select “Detection Formats”, then choose “New”, and select the appropriate
instrument. A new detection format will be created.

6453TA

El User Access
~Current Password
~Users and Groups
~System fettings
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~View logged in users
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Clean-up database
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4. Select the appropriate excitation and emission filter combinations for the O
dyes in your multiplex using the “Filter Combinations Selection” window.

Set the max integration time to 0.25 for all four color channels. m
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5. Select “Close” to save the new detection format into the database, and
return to the startup screen.

6. To access this newly created detection format, the LightCycler® 480
software must be closed, then reloaded.

7. After closing and reloading the software, select “New Experiment” in the
startup screen

8. Choose the appropriate detection format from the pull-down menu.

Multi Color HybProbe

6456TA

9.  Enter the reaction volume.
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10.  The cycling program should mimic a typical PCR. This cycling will consist
of four programs. Program the instrument by adding the program names
in the top window. Select the “+” icon to add a program. In the “Program
Name” section, name the first program of this experiment “Denature” or a
similar title. In the “Analysis Mode” pull-down menu, select “None”.

11.  With the “Denature” program name selected, change “Program
Temperature Targets” to the values indicated below.

l’_\"l D Programs I : e
=) qram Cyclos Anal
Add new (B{penacuce 1 = —';l'm -
| |PCR 40 S|Quantification -
prOgl’am [— Beit B E Color Compansasion ¥)
| |ceoiing I Zfpone -
Add new R“l ._‘;L;!.. e
l‘—“| Target (C) | Acquisition Mode | Hold (uhcmmiss) | Ramp Rate | Acquisitions (per | Sec Targat | Step Siza | Stop Delay
step to : | B I = ] a9 m 9 | loydes
—_—> Ib 95 o #|00:02:00 2.4 = = = =0 ERS
selected o~ g
program

12. Next to “Program Name”, select the “+” button to add a program. Name
the second program of this experiment “PCR” or a similar title. Enter the
number of amplification cycles. In the “Analysis Mode” pull-down menu,
choose “Quantification”.

13.  With the “PCR” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 60°C target temperature selected,
change the acquisition mode to “Single”.

Programs
| Program Hame | Cycles Analysis Mode
Denature It 2|tone -
b PCR |10 S guantification -
Helt 1 #lcolor Compensation =
eonling I SHone -

CRTi Targets |
. Target '0 | Acquisition Mode mnm| Ramp Rate | Acquisitions (per  Sec Target supsun‘ Step Delay |
rCs) ‘a | e ra

Hos ={Hone 00:00:05 31,1 B o =0 =
F Algy - p— = = | =] = =R
-|!au_ 2|singie Flezcozas slz.2 - = (0 2o v .| 2
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14.  Next to “Program Name”, select the “+” button to add a program. Name O
the third program of this experiment “Melt” or a similar title. In the
“Analysis Mode” pull-down menu, choose “Color Compensation”. Pl'omega

15. With the “Melt” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 95°C target temperature selected,
change the acquisition mode to “Continuous” and change “Acquisitions

(per °C)” to 2.5.
Setup
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czoling 1 SlWone -
& =
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16. Next to “Program Name”, select the “+” button to add a program. Name
the fourth program of this experiment “cooling” or a similar title. In the
“Analysis Mode” pull-down menu, choose “None”.

|;uvduw]n.-m EI- Binck Typa [ Piate 10 [ Reaction Volume [Z 3]
)

: i~
L Taiger [ Q) | Acquisition Mode | Hold (hhummess) nu:pmmu mhu;h:'{m-w?gln Step Delay <
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17. With the “cooling” program name selected, change “Program
Temperature Targets” to the values indicated below.
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O II1.B. Color Compensation Sample Editing

P 1. Sample information can be entered before, during or after a run.
2. Select “Subset Editor”.

3. Click “New” to create a new subset. Highlight the wells in the plate that
contain the color compensation reactions, then select “Apply”.

| mmm |

1 ] ] o R A
o
8] L] |

6461TA

4. Select “Sample Editor”. In the “Subset” pull-down menu, choose the
subset containing your color compensation reactions.

5. Under the “General” tab, indicate which are replicate wells. Color
compensation reactions should be run in replicates of 3-5. Name the
samples if desired.

6462TA
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6. Under the “Color Comp” tab, indicate the dominant color channel for each O
color compensation sample, using the “Dominant Channel” pull-down

menu. For “No Dye” samples, “Water” should be selected as the dominant m
channel.

“lsse-e10 (s58-€10) |

le15-670 (€15-€70)

6463TA

7. Select “Experiment” to return to the experiment window.
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O II1.C. Color Compensation Reaction Setup

You will need a separate color compensation reaction dedicated to each individual
l’romega dye in your multiplex, as well as a reaction with no dye (Table 2). Each of these
color compensation reactions should be run in replicates of 3-5. The same Plexor™
primers that will be used in your experimental samples can be used to set up the
color compensation reactions. The primers in the color compensation reactions
should be used at similar concentrations to those in the experimental reactions.
When using Plexor™ primers, it is not necessary to add template to the color
compensation reactions.

Note: The volumes listed in Table 2 are for use with a 96-well reaction plate. When
using a 384-well reaction plate, reaction components should be scaled down to a
final volume that is compatible with that plate. Plexor™ reaction components have
been used successfully in reaction volumes as low as 5pl. In a 384-well reaction
plate, 10pl final volumes are commonly used.

Table 2. Color Compensation Reaction Setup

Reaction Components Plexor™ Dye Reaction No Dye Reaction (Blank)
2X Plexor™ Master Mix 12.5u1 12.5p1

Plexor™ primer 1ul -
MOPS/EDTA Buffer 11.5pl 12.5ul

Total Volume 25ul 25ul

1. Setup the color compensation reactions on ice in a LightCycler® 480
multiwell reaction plate.

2. Mix each color compensation reaction thoroughly.

3. Cover the reaction plate with an optical adhesive cover using the
applicator. Centrifuge briefly to collect contents at the bottom of each well.

4. Load the reaction plate into the LightCycler® 480, and immediately press
“Start Run” to begin thermal cycling.
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IILD. Creating a Color Compensation Analysis File O
1. When the run is complete, select “Analysis”.
2. Inthe “Analyses” pull-down menu, choose “Overview”.

3. Inthe “Create new analysis” list, select “Color Compensation”.

Analyses IO\’crvic\r
Create new analysis—————

ibs Quant/2nd Derivative Nax
Abs Quant/Fit Points

|Color Compensation |
Tm Calling

6464TA

4. When the “Create new analysis” pop-up window appears, select the
sample subset containing your color compensation reactions from the
“Subset” pull-down menu. Select “OK”.

Create new analysis L

Analysis Type *lCOlor Compensation j
Subset '*‘INem Subset 1 :i
Program *lnelt |
Name '*ICO].DI Compensation for New Subset 1

1

6465TA

“OK” button
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O 5. Select “Calculate” to perform the color compensation analysis. For each
filter combination, the “Raw Data” chart shows the raw fluorescence data
Pranega while the “Compensated Data” chart shows the fluorescence after the
color compensation has been applied.

fFoior compensation for Naw Subser 1

6466TA

6.  Select “Save CC Object” to save this color compensation analysis to the
database. This color compensation file can now be applied to data in
another experiment.
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IV. Instrument Setup and Thermal Cycling for qPCR and Two-Step qRT-PCR O

These instructions describe instrument setup and thermal cycling conditions for DNA

or cDNA quantitation using the Plexor™ gPCR or Plexor™ Two-Step qRT-PCR l,romega
System. Thermal cycling programs described in this manual are optimized to work
with primers designed using the Plexor™ Primer Design Software. The Plexor™
Primer Design Software can be accessed at: www.promega.com/plexorresources/

IV.A. Thermal Cycling Program

The thermal cycling program is shown in Table 3. Primers designed using the
Plexor™ Primer Design Software have an annealing temperature of approximately
60°C.

Table 3. qPCR and Two-Step qRT-PCR Thermal Cycling Program.

Step | Temperature Time | Number of
Cycles
Initial
Denaturation: | 95°C 2 minutes | 1 cycle
Denaturation: 95°C 5 seconds
Annealing and 40 cycles
Extension: 60°C 35 seconds
Denaturation: | 95°C 5seconds | 1 cycle
Melt
Temperature 50°C to 95°C, 2.5 acquisitions per °C
Curve:
Instrument Cool: | 50°C 30 seconds | 1 cycle
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O 1. Open the LightCycler® 480 software.
2. Select “New Experiment” in the startup screen.

instrumant:  LCIEN_1243  Stamdby oo S} Database: My Computar (Traceahle)
Window:  [verview E| User:  System Admin

@y B8 0

|[®|&|@

[l

=

- e

3. Select the appropriate detection format from the pull-down menu. The
detection format specifies which fluorescent channels will be read (created
in Section IIL.A).

6453TB

Multi Color HybP

FAN-CO560~-CREIS-QETO d

6467TA

4.  Enter the reaction volume.
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5. The cycling will consist of four programs. Program the instrument by O
adding the program names in the top window. Select the “+” icon to add a
program. In the “Program Name” section, name the first program of this Pro
experiment “Denature” or a similar title. In the “Analysis Mode” pull- g
down menu, select “None”.

6. With the “Denature” program name selected, change “Program
Temperature Targets” to the values indicated below.

i
| Detection Format [Fimwor ~|- Block Type [ Plate 10 | Reaction Volume [= =]

A : Programs _

__Program Name | Cycles Analysts M
#|Denatuce 1 Z|wone -

. PCR a0 | Quancification -

.'"nm It =lelting Curves =
|eooling 1 lwone =

A PM!W_WE

L_J Targot {C) | Acquisition Mode | Hold (hhimm:ss)  Ramp Rate  Acquisitions {por | Sec Targot| Stap Size | Stop Dalay

. o ‘a q ro el £
CES b =|09:02:00 4.4 = 2 = [ zlo ¢

7. Next to “Program Name”, select the “+” button to add a program. Name

the second program of this experiment “PCR” or a similar title. Enter the
number of amplification cycles. In the “Analysis Mode” pull-down menu,
select “Quantification”.

8. With the “PCR” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 60°C target temperature selected,
change the acquisition mode to “Single”.

Setup

Detection Format [Ficxor gl - Block Type | Plate 10 | Reaction Volume [ 2]
.- Frograms
_ Program Hame | Cycles Analyeis Mode
Denature i (Mone -
M PCR 40 =|Quancificacion >
-'j‘ne_x_c 11 S{felting Curves =
|coeling 1 |Hone -
. el
I A] Target (€) | Acquisition Mode | Hold fhhemmss) | Ramp Rate T"M“!g;.‘mn {per | Sec Target| Stap Size | Step Delay
(=] ‘0 9 (] (cycles)
bas ZHone =[o0:00:08 24 = =zl =0 =0 =
.' 50 H e 00:00:35 8la.2 = o 2o zlo -
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O 9. Next to “Program Name”, select the “+” button to add a program. Name
the third program of this experiment “Melt” or a similar title. In the

l’ro.nega “Analysis Mode” pull-down menu, select “Melting Curves”.

10.  With the “Melt” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 95°C target temperature selected,
change the acquisition mode to “Continuous” and change “Acquisitions

(per °C)” to 2.5.
|n|:ﬂ|ll|mﬂ|l;ux-.-: g- mnTnll-Ja mm| Reaction Valuma |3'; al
Programs e
QL_}JL
1 =ltena -
40 = ificatl -
L A
1 -
_ Mol Tormparature Tagets
Mode | Haold (b | Hamp Rate  Acquisitions (per | Sec Target | Step Size  Step Dalay
R a ra ("] frycles)
e =loo:o0:0s Tl4.4 g = 5 =i
Hene 00:00:30 .z : = g
= Continuous 3 =22 ﬂ §

11.  Next to “Program Name”, select the “+” button to add a program. Name
the fourth program of this experiment “cooling” or a similar title. In the
“Analysis Mode” pull-down menu, select “None”.

12, With the “cooling” program name selected, change “Program
Temperature Targets” to the values indicated below.

e,
| Setup-

Detection Format [F1=nor -[- Block Type |- Plate 10 | Reaction Volume [= 2]

. Frograms
__ Program Name
Denature
.: FCR
| melc
. Heaaling
v

e Ta
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5 < R AL e :
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50 =iNone =|on:00:30 =l o =0 =lo =

B6471TA

=il

Promega Corporation -2800 Woods Hollow Road -Madison, WI 53711-5399 USA - Toll Free in USA 800-356-9526 - Phone 608-274-4330 - Fax 608-277-2516 -www.promega.com
Part# TM290 Printed in USA.

Page 16 5/07



IV.B. Sample Editing O

1. Sample information can be entered in the LightCycler® 480 software

before, during or after your experiment is run. Alternatively, sample Pfomega
names can be entered during the data analysis step using the Plexor™

Analysis Software.

2. To enter sample information using the LightCycler® 480 software, select
“Sample Editor”.

411 Samplez 53568 | B 55 | 551
N EETeIE R [7 815 hafvhz

Saxple 1
Sample 2
Jemola.3
Sample 4
Sample 5
Saxple €
Saxple 7
Sawmple &
Jazple 9
Sanple 10
Saxple 11
Sawple 12
Sewple 13
Saxmple 14
Saxmple 15
Sample 16
Sawple 17
Sazple 18
Saxple 19
Sazple 20

Ermrrn =

=] o= m|e]n] =] ]

6472TA

3. Under the “General” tab, indicate which are replicate wells. Name the
samples if desired.

4. Select “Experiment” to return to the “Experiment” window.

5. Load the reaction plate into the LightCycler® 480, and immediately press
“Start Run” to begin thermal cycling.
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O V. Instrument Setup and Thermal Cycling for One-Step qRT-PCR

These instructions describe instrument setup and thermal cycling conditions for
Promega cDNA quantitation using the Plexor™ One-Step qRT-PCR System. The thermal
cycling program includes the initial incubation for the reverse transcription. Thermal
cycling programs described in this manual are optimized to work with primers
designed using the Plexor™ Primer Design Software. The Plexor™ Primer Design
Software can be accessed at: www.promega.com/plexorresources/

V.A. Thermal Cycling Program

The thermal cycling program is shown in Table 4. Primers designed using the
Plexor™ Primer Design Software have an annealing temperature of approximately
60°C.

Table 4. One-Step qRT-PCR Thermal Cycling Program.

Step | Temperature Time | Number of
Cycles
Reverse
Transcription®: | 45°C 5 minutes | 1 cycle
Initial
Denaturation and +

Inactivation of the
ImProm-II™

Reverse
Transcriptase; | 95°C 2 minutes | 1 Cycle
Denaturation: 95°C 5 seconds
Annealing and 40 cycles
Extension: 60°C 35 seconds
Denaturation: | 95°C 5seconds | 1 cycle
Melt Temperature 50°C to 95°C, 2.5 acquisitions per °C
Curve:
Instrument Cool: | 50°C 30 seconds | 1 cycle

1The length of incubation for the reverse transcription reaction can be increased to up to
30 minutes. Longer incubation times can lead to increased sensitivity but also higher
background.
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1. Open the LightCycler® 480 software. O
2. Select “New Experiment” in the startup screen.

nstrumant: LCAED_ 1243 Stamiby fno S Datahasn: My Compater (Traceabie)
ENIM 'O—nh- d Usur: System Admin

T B

[s

B [®

K

- =

3. Select the appropriate detection format from the pull-down menu. The
detection format specifies which fluorescent channels will be read (created
in Section IIL.A).

6453TB

Multi Color HybP

FAN-CO560~-CREIS-QETO d

6467TA

4. Enter the reaction volume.
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The cycling will consist of four programs. Program the instrument by
adding the program names in the top window. Select the “+” icon to add a
program. In the “Program Name” section, name the first program of this
experiment “Reverse Transcription and denaturation/inactivation” or a
similar title. In the “Analysis Mode” pull-down menu, select “None”.

With the “Reverse Transcription and denaturation/inactivation” program
name selected, change “Program Temperature Targets” to the values
indicated below. To add new steps, select the “+” button in the lower
window.

5,
Setup

Detection Format [ oo -I- Black Type [35 Plate 1D | Reaction Volume [5 =

Programs

Program Name

Reverse Transcriptlon and denaturation/inactivarion
PCR

Helt

[cooling

Analysis Mode
[None
Quantification

| Cycles
|11

(4D
£
X

Belting Curves
None

fsfe isfafo]e ]
CIENENE

Reverse Transcription and denaturation/inactivation Temperature Targets

=l e

Target (Q

Acquisition Made

Hold (hh:mmi:ss)

Ramp Rate
res)

Acquisitions {per Sec Target
- g

aQ

Step Size
ra

Step Delay

-

45

Naons

00:05:00

4.4

=l

=lo

alefas

None

00:02:00

= Er

o

o

Qoo
6473TA

Y P@> KO® >

Next to “Program Name”, select the “+” button to add a program. Name
the second program of this experiment “PCR” or a similar title. Enter the
number of amplification cycles. In the “Analysis Mode” pull-down menu,
select “Quantification”.

o

With the “PCR” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 60°C target temperature selected,
change the acquisition mode to “Single”.

Setup
Detection Format [71=2x 3- Block Type [ Plate 10 [ Reaction Volume [ 2]

5

3

Programs

Analysis Moda

Hone

Program Name

Feverse Transcription arnd deraturaticon/inactivation
FCR

Kelt

cooling

ciZication
ting Curves
Hone

i
Acquisition Mode | Hold (hhimm:ss)

[None
Fingle

Target 'Q

95
€0

SlcTaqcl| supﬂnl Step Delay
@ | [0

]
D_

o
o

*|oo:00:05
“[o0:00:35

s #a o

-

bt
6474TA

0@ ©
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9. Next to “Program Name”, select the “+” button to add a program. Name O
the third program of this experiment “Melt” or a similar title. In the

“Analysis Mode” pull-down menu, select “Melting Curves”. Pl'omega

10.  With the “Melt” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 95°C target temperature selected,
change the acquisition mode to “Continuous” and change “Acquisitions

0 ”
(per °C)” to 2.5.
Setup
Detection Format [Fi=xor | - Black Typs [55 Plate 10 | Reaction Valume [5 5]
Programs

Program Name Cycles Analysis Moda
] Reverse Transcripticn and denaturaticn/insctivaricn 1 % None :
FCR 40 =|Cuancification >
b{Helc | ‘_%_ Helting Curves -
cooling 1 i Hone Jd

None =[o0:00:08 - N

Hone 00:00:30
Z1Cont inucus

4 lae au e
-
-
4
i

ananng

FIEIE]

6475TA

% Torget (C) | Acquisition Mode | Hold (hhommess) m;mew he&qu“«;&m nm\
a
11

Next to “Program Name”, select the “+” button to add a program. Name
the fourth program of this experiment “cooling” or a similar title. In the
“Analysis Mode” pull-down menu, select “None”.

12. With the “cooling” program name selected, change “Program
Temperature Targets” to the values indicated below.

nm-. Fomat [Fimoe o (Cumomiaey BlockType [0 Plawin[ Reaction Volums [ 2]
_____l_’mlhnl 3 Analysis Mode
Feverse Teanscriprion and denaturation/inactivetion 1 =lHone =
FCR 40 Quantification hd
Halt 1 Kalting Curves b
Flcooling 1 Hone fd
xJ\
pr— A ]
A” caoling | Targets
S0 TargetrQ | Iqlhllmlodc-l Hold (hhzmmiss) hw |Aﬂ|ﬂhlhutnr Sec Target Size | Step Delay
I ‘0 (g2} e} (opcles) | £
¥sc [wone *|o0:00:30 =22 = zlo zlo =0 5
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O V.B. Sample Editing

1. Sample information can be entered in the LightCycler® 480 software
Pfomega before, during or after your experiment is run. Alternatively, sample

names can be entered during the data analysis step using the Plexor™
Analysis Software.

2. To enter sample information using the LightCycler® 480 software, select
“Sample Editor”.

411 Samples 3568 | 615570 | 5581
Tz (al5[6 (7 8] pofhz

DR

Saxple 1
Savple 2
Saxple 3
Sanple 4
Saxple 5
lqll L3
Jaaple 7
Sawple 8
Saple 9
Sample 10
sazple 11
Sawple 12
Saxple 13
Sample 14
Saxple 15
Sample 16
Saxple 17
Sample 18
Saxple 19
Sample 20

=ty 1=

=] =] |

6472TA

3. Under the “General” tab, indicate which are replicate wells. Name the
samples if desired.

4. Click “Experiment” to return to the “Experiment” window.

5. Load the reaction plate into the LightCycler® 480, and immediately press
“Start Run” to begin thermal cycling.
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VI. Instrument Setup and Thermal Cycling for Genotyping (SNP) Assays O

These instructions describe instrument setup and thermal cycling conditions for P
genotyping assays using the Plexor™ gPCR System. This cycling program is specific mega
for genotyping primers designed using the Plexor™ Primer Design Software.
Thermal cycling programs described in this manual are optimized to work with
primers designed using the Plexor™ Primer Design Software. The Plexor™ Primer
Design Software can be accessed at: www.promega.com/plexorresources/

VIA. Thermal Cycling Program

The thermal cycling program is shown in Table 5. The cycling program will include
one cycle with an annealing temperature of 50°C, followed by 40 cycles with an
annealing temperature of 60°C. The first round of PCR is performed at the lower
annealing temperature; additional rounds of PCR are performed at the higher
annealing temperature to increase the specificity of amplification.

Table 5. Thermal Cycling Profile for Genotyping Assays.

Step Temperature Time Number of
Cycles
Initial
Denaturation: 95°C 2 minutes 1 cycle
Annealing and .
Extension: 50°C 35 seconds
Denaturation: 95°C 5 seconds
Annealing and . 40 cycles
Extension: 60°C 35 seconds
Denaturation: | 95°C 5 seconds | 1 cycle
Melt Temperature 50°C to 95°C, 2.5 acquisitions per °C
Curve:
Instrument Cool: 50°C 30 seconds 1 cycle
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iv\l-m [oveeview E| Usur: Systom Admin

- e

1. Open the LightCycler® 480 software.

2. Select “New Experiment” in the startup screen.

nstrumant: LCAED_ 1243 Stamiby fno S Datahasn: My Compater (Traceabie)

@y B 0

@<l

[l

=

6453TB

3. Select the appropriate detection format from the pull-down menu. The

detection format specifies which fluorescent channels will be read (created
in Section IIL.A).

Multi Color HybP

FAN-CO560~-CREIS-QETO d

6467TA

4.  Enter the reaction volume.
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The cycling will consist of four programs. Program the instrument by
adding the program names in the top window. Select the “+” icon to add a
program. In the “Program Name” section, name the first program of this
experiment “Plexor first step genotyping” or a similar title. In the
“Analysis Mode” pull-down menu, select “None”.

6. With the “Plexor first step genotyping” program name selected, change
“Program Temperature Targets” to the values indicated below.
| Blaction Foxmaet7exor ] (Customizey  Btock Typs [ Plate b | Reaciion Volume [ 2]
Al Programs
Program Name | Cydes  Analysis Mode
¥|[Plcxor firot otep gsnotyping 1 Zivone -
. FCR 40 S{Quantification -
Eelt | Z|felting Curves B
| [cecling 3 SlHone -
) BLLE
. Temperature Targets
Target (') q Mode | Hold Hamp Hate | Acquisitions (per  Sec Target  Step Size | Step Delay
sl 9 () 9
a5 =lhone 00:02:00 2ls.0 = o = =iy 3 -
-1| =0 Z|tonz =|oo:00:38 2.z z zlo zlo 3 :I S

7. Next to “Program Name”, select the “+” button to add a program. Name
the second program of this experiment “PCR” or a similar title. Enter the
number of amplification cycles. In the “Analysis Mode” pull-down menu,
select “Quantification”.

8. With the “PCR” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 60°C target temperature selected,
change the acquisition mode to “Single”.

Detection Farmat [Fioee o] (Customiee¥ BlockType [0 Plaetd [ ReactionVolume [= 3]

5 — "
Program Name Cycles Analysis Mode
Flexor first step genctyping 1 Hone >

.};;cr\ 40 |quantizication =l

.|_5=u 1 S{felting Curves 3|
cocling 1 «|HOone hed

6478TA
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O 9. Next to “Program Name”, select the “+” button to add a program. Name
the third program of this experiment “Melt” or a similar title. In the

lmega “Analysis Mode” pull-down menu, select “Melting Curves”.

10.  With the “Melt” program name selected, change “Program Temperature
Targets” to the values indicated below. To add new steps, select the “+”
button in the lower window. With the 95°C target temperature selected,
change the acquisition mode to “Continuous” and change “Acquisitions

(per °C)” to 2.5.
Detaction Format [Fienor 3'- Block Type [ Plate 10 [ Reaction Volume [= 2]
. Programs
Program Name Cycles Analysis Moda
.| Plexcr fiEst Step geroTyping 1 =Itone -
FCR 40 *lguantizication -
e 1 =|Belting Curves =
coeling 1 i Hone =]
v - |
. Melt Temp Targets
Target (') | Acquisition Mode mum| m?tp“m- !cwll'ﬂgutnr
-295 - =loo:c0:0s sla.a = = = .
50 Zlucne oo:00:30 =2z - 5
- a5 | tonz inuous = Sz.5 33
11.  Next to “Program Name”, select the “+” button to add a program. Name

the fourth program of this experiment “cooling” or a similar title. In the
“Analysis Mode” pull-down menu, select “None”.

12, With the “cooling” program name selected, change “Program
Temperature Targets” to the values indicated below.

Satup
Detection Format [F1=xoc | - Hlock Typs [ Plate 10 | Reaction Volume [55 =]
' Programs
Program Name Cycles Analysis Mode
Flexor first step gerotyping 1 _—"-lrom f:
. Jrcn 40 Z|Quantification -
o e
. Hleccling 1 - -
v
'}_\"1[ cooling Tamparature Targots
S Tagetrg | Acquisition Mode | Hold (hhmmiss) | Ramp Rate | Acquisitions (per | Sec Target | Step Size ‘ Step Delay
‘a ra (8] feyeles)
.pso 2[rvone =|oo:on:30 z.2 = ) =0 'g: de
=\l g
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VLB. Sample Editing O

1. Sample information can be entered in the LightCycler® 480 software
before, during or after your experiment is run. Alternatively, sample m
names can be entered during the data analysis step using the Plexor™
Analysis Software.

2. To enter sample information using the LightCycler® 480 software, select
“Sample Editor”.

411 Samples 3568 | 615570 | 5581
Tz (al5[6 (7 8] pofhz

DR

& |

§

w

g
6472TA

= =il

3. Under the “General” tab, indicate which are replicate wells. Name the
samples if desired.

4. Click “Experiment” to return to the “Experiment” window.

5. Load the reaction plate into the LightCycler® 480, and immediately press
“Start Run” to begin thermal cycling.
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O VII. Data Export from the Roche LightCycler® Data Analysis Software

Before the data can be analyzed using the Plexor™ Analysis Software, the data must
l’romega be exported from the LightCycler® 480 software. Two *.txt files must be exported for
each color channel used: one with the amplification data and one with the
melt/dissociation data. Be sure to use a descriptive name when naming these files so
that it is clear which file contains the amplification data and which file contains the
dissociation data while still indicating that the files are related.

Preliminary analysis must be performed using the LightCycler® software.

1. Open the experiment to be analyzed. Analyses|overvicy

2. Click on “Analysis” on the toolbar. Create new analysis————————
Abs Quant/Znd Derivactive Hax

3. To analyze the amplification data, select Abs Quant/Fit Points |

Color Compensation

“Overview” in the “Analyses” pull-down
T Calling

menu. From the “Create new analysis”
list, select “Abs Quant/Fit Points”.

6481TA

4. Inthe “Create new analysis” pop-up window, confirm that “PCR” is selected
in the “Program” pull-down menu. Selecting “All Samples” in the “Subset”
pull-down menu will result in analysis of the entire plate. Alternatively, if the
experiment contains previously defined subsets of samples, a specific subset
can be chosen for analysis. Select “OK” to proceed.

Create new analysis

Analysis Type '*‘Inbs Quant/Fit Points :l
Subset -*-lau Semples -v]
Program *lPCR ;I
Name *Inbs Quant/Fit Points for All Sample
1 21304508078 810|012
A
B
£
D
E
F
G
H

6482TA
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5. Amplification curves are displayed in the chart. For multiplex data (i.e., more O
than one dye), a color compensation file must be applied. Select the “Color
Comp” button, and choose “In Database”. From the “Available Color l,ro
Compensations” list, select the appropriate color compensation file and select g
“OK”. In the “Color Compensation Channels” box, choose the channels to
compensate and select “OK”.

Color Compensation Channels

Select channels to compensate.

V' 523568 (523-568)
¥ 615670 (615-670)
V" 558610 (558-610)
V" 483533 (483533)

6.  The “Filter Comb” button indicates the color channel being displayed. To view
each color channel, select “Filter Comb”, and choose the channel you wish to
display. The fluorescence data must be exported separately for each color
channel.

6483TA

Filter Combination

523-568 (523-568)
615-670 (615-670)
558-610 (S558-610)
483-533 (4B83-533)

6484TA
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O 7. To export the amplification data, right-click on the “Amplification Curves”
chart and select “Export” from the menu.

6485TA

8. In the “Export” chart window, select the “Data” tab. Choose “Text” as the
format. Include “Point Index”, “Point Labels” and “Header”. The file should be
tab-delimited.

9.  Assign a descriptive name to the file in the “Filename” box, so that it is clear
the file contains the amplification data for that specific color channel. Choose
the “...” box to select a location to save the file, then select “Export”.

6486TA
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10.  For multiplex reactions, each dye channel must be exported separately by O
repeating Steps 6-9. In Step 6, use the “Filter Comb” button to change the color

channel being displayed to export data from each of the color channels. Pl"omega
11.  To analyze the melt data, select Anslysss|overvies

“Overview” in the “Analyses” Ciaats muv smalysis

Mbs Quant/2nd Derivative Max
pull-down menu. o= Cuanc/Fit Points
. . Color Compensatich

12. From the “Create new analysis” list, T Calling

select “Tm Calling”. g

13.  In the “Create new analysis” pop-up window, confirm that “Melt” is selected
in the “Program” pull-down menu. Selecting “All Samples” in the “Subset”
pull-down menu will result in analysis of the entire plate. Alternatively, if the
experiment contains previously defined subsets of samples, a specific subset
can be chosen for analysis. Select “OK” to proceed.

Create new analysis

Analysis Type [T Calling K|
Subset #[a11 sampies |
Program #[uelc =l
Name #[™n calling for All Samples
1lz]3 |45 |78 |a]0]n]i

A

B

=

D

E

F

(

H
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O 14.  Melting curves are displayed in the upper chart. For multiplex data (i.e., more
than one dye), a color compensation file must be applied. Select the “Color
l’romega Comp” button, and choose “In Database”. From the “Available Color
Compensations” list, choose the appropriate color compensation file, and select
“OK”. In the “Color Compensation Channels” box, choose the channels to
compensate, and select “OK”.

15.  The “Filter Comb” button indicates the color channel being displayed. To view
each color channel, select “Filter Comb”, and choose the channel you wish to
display. The fluorescence data must be exported separately for each color
channel.

16. To export the melt data, right-click on the “Melting Curves” chart, and select
“Export" from the menu.

Melting Curves

33516
g 28 5181
- 23516

16 516

13516
8516

§
8

17.  In the “Export” chart window, select the “Data” tab. Select “Text” as the
format. Include “Point Index”, “Point Labels” and “Header”. The file should be
tab-delimited.

18.  Assign a descriptive name to the file in the “Filename” box, so that it is clear
the file contains the melt data for that specific color channel. Choose the “...”
box to select a location to save the file, then select “Export”.

19.  For multiplex reactions, each dye channel must be exported separately by
repeating Steps 15-18. In Step 15, use the “Filter Comb” button to change the
color channel being displayed in order to export data from each of the color
channels.

20. If analysis will be done on a separate computer, save the files on removable
media or an accessible network location. These exported files are now ready for
use with the Plexor™ Analysis Software.

Note: The Plexor™ Analysis Software will use the greatest change in signal
throughout the imported data set to determine a signal threshold. This may
affect sensitivity of assays with lower signal if multiple types of assays (in the
same color) are being run simultaneously. This can be avoided by exporting the
samples for each assay separately.

Promega Corporation -2800 Woods Hollow Road -Madison, WI 53711-5399 USA - Toll Free in USA 800-356-9526 - Phone 608-274-4330 - Fax 608-277-2516 -www.promega.com
Part# TM290 Printed in USA.
Page 32 5/07



VIIL Data Import into the Plexor™ Analysis Software O

The Plexor™ Analysis Software (Cat.# A4071) is available for download at:

www.promega.com/plexorresources/. It is also available free-of-charge on CD-ROM l,romega
by request. Software installation instructions are given in Section XL.B.

When exporting data for use with the Plexor™ Analysis Software, be sure to assign
descriptive names to the files so that related amplification curve and melt curve files
(e.g., files generated using the same data) can be easily identified during data import.

1. To launch the Plexor™ Analysis Software, go to the “Start” menu and select
“Programs”, then “Plexor”; select “Analysis Desktop”.

Note: A shortcut can be placed on the desktop by right-clicking on “Analysis
Desktop”, selecting “Copy”, then right-clicking on the Windows® desktop and

selecting “Paste Shortcut”.
2 50

In the “File” menu, select “Import New Run” or select the icon:

3. Optional: Enter an assay name in the “Assay Setup” screen (Figure 1). This
screen is used to enter general information about the type and format of the
data that will be used for each assay.

4. Select “Roche LightCycler 480" as the “Instrument”. Select either “96 Well
Block” or “384 Well Block”, as is appropriate for your sample run.

Assay Setup Expor

In order 1o define the assay you wish to import, please specify the following
paramelers. (== Required )
Assay Name - Please enter the name of this assay

Instrument” - Please select the supparted instrument for this assay

LightCycler 480 (95 Well Block)
']R.o-:he LightCycler 430 (334 Well Block)
“BicRad iCycler iQ
leichiad Cycer I (via paste)
SBicRad 105

Cancel Next>

6490TA

Figure 1. The Assay Setup screen.

5. Select “Add Target” for each fluorescent dye used in your assay. For each dye,
assign a target name, enter the dye name and indicate that there is amplification
data and dissociation (melt) data to be analyzed for that dye. The name of the
dye must be the same as that in the original exported data file .

Note: For frequently run assays, a template with the target information and
dyes can be saved (Section XI.C).

6.  Select “Next”.
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O 7. Enter information specific to your experiment in the “Run Info” screen
(Figure 2). Details (date, notes, title, name of the person performing the

l’ro.“ega experiment, etc.) can also be entered in the provided windows.

Run Info
Pleasze fill in the details below regarding your rn.
Run Details
Assay Name:
Instrument: Roche LightCyder 430 (96 Well Block)

'lile=[_ B |

Cancel < Back Next>

6491TA

Figure 2. The Run Info screen.

8. Select “Next”.

9. Use the “File Import” screen (Figure 3) to specify the data files exported
from the instrument in Section VII. Use “Browse” to locate the appropriate
exported amplification and dissociation data files.

When analyzing data with the Plexor™ Analysis Software, be sure to
choose the amplification curve file and melt curve file generated using the
same data. The file names assigned when exporting data must be
descriptive so that the appropriate files can be easily identified and
imported into the Plexor™ Analysis Software.

Note: “Advanced Options” can be used to create templates for routine
plate setups and analysis conditions. See Section XI.C for details
concerning these advanced options and an explanation of the default
analysis settings.
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File Import O

To import your LightCycler480 run, use the file dialogs below to specify the files for each dye used for
amplification and melt as labeled below. l,ro
e _ mega
CRETS
Filename:

3

cose0

Cancel < Back Finish

6492TA

Figure 3. The File Import Screen.

10.  Select “Finish” to complete the data import and to open “Analysis
Desktop”.
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O IX. Data Analysis with the Plexor™ Analysis Software

After data import is complete (Section VIII), the “PCR Curves” tab of the “Analysis
Pro"'ega Desktop” is displayed (Figure 4).

Fin EM e Wedkm twp

|o|@|w| BB e o s kR
Tab Selection e L

Fams ot 1| sou . Tapera |

Tools

Amplification
Curves Window

Melt Curves
Window

Well Selector

504RTA

Figure 4. The PCR Curves tab of the analysis desktop. The amplification curves window,
melt curves window and well selector are indicated.

IX.A. Sample Definition

1. Use the “Well Selector”, which is shown in Figure 4, to select and define
each well or group of wells. Choose one of the icons shown in Figure 5 to
define the samples. See Notes 1-5.

2. To assign sample names, select the “Sample IDs” tab (Figure 6). To enter
sample names manually, select the well, and enter the desired sample
name. Repeat to enter sample names for other wells.

To copy names from a MicroSoft® Excel spreadsheet, highlight the sample
names in the spreadsheet and select “copy”. In the “Edit” menu, select
“Paste Sample IDs from Template” or use the control T shortcut. The
layout of the sample names in the spreadsheet must be the same as the
layout of the samples within the PCR plate.
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Selecting the wells and choosing the “Create Dilution Series” icon can
automatically create a titration curve across several wells.
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Figure 5. The icons used to define samples in the Plexor™ Analysis Software.
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Figure 6. The Sample IDs tab.

Notes:

1. Sample definitions, color selection and concentration of standards
will be entered for all dyes. To define samples separately in each dye,
uncheck “Propagate Selection Across Dyes” in the “Edit” menu.

2. A sample or set of samples can be permanently deleted from a Plexor™
analysis. Go to the “PCR Curves” tab, and select the samples. Use the
delete key or select “Remove Selected Wells” in the “Edit” menu.

3. All samples defined as standard reference templates must be assigned a
concentration. Concentrations may be entered in standard format (0.01,
0.1, 1,10, 100, 1000, etc.) or scientific format (1e-2, le-1, 1e0, 1el, 1e2,
1e3, etc.). Standard reference templates with the same concentration
may be assigned simultaneously by highlighting multiple wells. The
software does not accept commas in the concentration assignments.
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O 4. Arow or column of contiguous wells within a dilution series of
standard reference templates may be simultaneously assigned as
l’romega standards using the “Assign Dilution Series” function by highlighting
multiple wells (Figure 7). You must enter the initial concentration of
the series, the dilution factor and whether the series is increasing or
decreasing.

5. Colors can be assigned to samples to provide distinction to the
displayed data. Select the samples, then select “color assignment” to
apply a color to the selected sample(s).

Assigning or changing a color does not alter the information associated
with a sample. For example, the concentrations of standard samples
will be retained if the display color associated with those samples is
changed.

Assign Dilution Series x|

(" Horizontal Series

Starting Concentration: |1

Dilution Factor: {10
(¥ Increasing
(" Decreasing

Apply Cancel

5049TA

Figure 7. The Assign Dilution Series screen.

IX.B. Adjusting the Expected Target Melt Temperature

Set the expected target melt temperature and the expected target melt temperature
range. Failure to set the range for the expected target melt temperature correctly will
cause the results to be incorrectly reported in the graph legend and the “Reports”
tab (Section IX.F). For multiplex assays, the expected melt temperature range must
be adjusted for each dye.

1. Select the “PCR Curves” tab. The default setting for the expected target
melt temperature is 90.0, and the default target T, range is +/-1°C.

2. Select a well containing a standard reference template or genotyping control
sample. The T, for each selected sample will be displayed in a table to the
right of the graph (Figure 8). The expected target melt temperature and
associated target melt temperature range for all samples in this dye
channel should be set based on the T, of this standard or control sample.
See Note 1.
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Figure 8. The expected target melt temperature is displayed in a table to the right of the graph.

3. In the melt curves window, move the mouse so the arrow is over the
expected target melt temperature line, and drag it to the desired
temperature. Alternatively, double-click on the line, and enter the desired
temperature. See Notes 2-5.

4. Optional: The melt threshold may be reset to change the sensitivity in
detecting the amplification product. See Note 6. The default melt threshold
is set at 25% of the signal change for the sample within the set that has the
greatest change in signal. In some instances, the sample(s) used to set this
threshold may not be typical of the data set.

To adjust the melt threshold line based on a selected set of samples,
highlight the desired samples in the well selector. In the “Edit” menu,
select “Set Melt Threshold From Selected Samples”. Enter the desired
percentage of signal change.

To manually adjust the melt threshold line, place the cursor over the
threshold line, and drag the line to the desired location. Alternatively,
double-click on the threshold line, and enter the desired threshold value.

Notes:

1. The absence of peaks for the standard reference template or genotyping
control sample indicates amplification problems. See Section X for more
information about possible causes.
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@ 2. The target melt temperature range can be adjusted manually. Move the
mouse so that the arrow is over the upper or lower limit, and drag the
l’romega limit to the desired temperature. Alternatively, upper and lower limits can
be adjusted by double-clicking on the appropriate lines and entering an
exact value in the pop-up window that appears.

3. The melt threshold is the level of signal that must be reached for the
Plexor™ Analysis Software to “call” the melt results. Target T, indicators
are included in the table to the right of the amplification and melt curve
windows.

4. A"Yes” or “No” in the “Tm?” column indicates whether a sample T, is
within the expected target melt temperature range. A “No Call” in this
column indicates the melt curve displays the correct expected target melt
temperature, but there is insufficient amplification product to cause the
amplification curve to cross the melt threshold.

5. The “Tm#” is the number of peaks that cross the melt threshold line. More
than one peak indicates heterogeneous amplification products. This may
be due to nonspecific amplification, secondary structure or a polymorphic
target. See Section X for more information about possible causes.

6.  Changes made to the melt threshold line will apply to the entire data set
within the same dye channel, including those samples that were not
selected.

IX.C. Adjusting the Y Axes of the Amplification and Thermal Melt Curves
(Optional)

The scales of the Y axes for the amplification curve and melt curve in an experiment
are determined by the sample that yields the most amplification product (i.e., the
sample with the greatest decrease in signal). These scales are set for the entire data set.

The scale of the Y axis can be set manually by double-clicking on the Y axis of the
graph and entering the new value in the pop-up window. This change will alter the
scale for the entire data set.

IX.D. Adjusting the Baseline Region and Amplification Threshold Line (Optional)

The Plexor™ Analysis Software automatically sets the baseline region for each
sample. The baseline is set in a flat region of the amplification curve before product
accumulation. Manual adjustment of baseline is possible. See Section XLD. for
information on display and adjustment of baseline regions.

The amplification threshold is used to determine the C, value for the samples
(Figure 9). The default amplification threshold is based on the variation (noise) in
the baseline regions of all samples. It is determined by taking the mean and
standard deviation of all RFU values in the baseline regions and setting the
threshold to 10 standard deviations below the mean.

Optional: If desired, the amplification threshold may be reset to change the
sensitivity in detecting the amplification product.
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1. To adjust the amplification threshold based on a selected set of samples, O
highlight the desired samples in the well selector. In the “Edit” menu,
select “Set Amp Threshold From Selected Samples”. Enter the number of Pro
standard deviations of the background within the baseline region to use. g
The default is 10 standard deviations.

2. To manually adjust the threshold, place the cursor over the threshold, and
drag the line to the desired location. Alternatively, double-click on the
threshold, and enter the desired value.

Note: Changes made to the amplification threshold will apply to the entire
data set within the same dye channel, including those samples that were
not selected.

«. The baseline and threshold reset button will reset the amplification
| ﬁt threshold to the default using all samples.

Duplex 1.aan - Mok for Medical Diagnostic Use.
PCR Curves | Sample i3] <1270rc Ciroes | Reponts]
FAM- Target1 | une - Targetz |

Ampl fication Curvas

Amplification
Threshold

5052TA

Figure 9. The amplification and melt thresholds.

IX.E. Generating a Standard Curve (Optional)

Amplification results from a dilution series of the standard reference template are
used to generate a standard curve. This standard curve can be used to determine the
concentration of unknown samples. A standard reference template with any unit of
concentration or amount can be used to generate the standard curve. In general, copy
number or mass is used, but other units that are appropriate for your experiment,
such as plaque forming units or dilution factors from a known stock, can be used.
Samples for generating the standard curve must be designated as standards (Section
IX.A). For multiplex assays, standard curves must be generated for each dye label.

1. Select the desired standard samples and the samples you want to quantify.
Select “Add Standard Curve” to generate a standard curve.

{\| Add Standard Curve
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@ 2. Select the “Standard Curves” tab to view the standard curve (Figure 10).
The default display shows the log concentration on the Y axis and the

l’romega cycle threshold on the X axis.

Alternatively the standard curve can be displayed with the cycle threshold
on the Y axis and the log of the concentration on the X axis (Figure 11). To
do so, select the “Standard Curves” tab to view the standard curve. In the

“Edit” menu, select “Flip Std. Curve Axes”. See Notes 1 and 2.

3. View the concentrations for all samples, including the unknown samples,
in the table next to the standard curve graph (Figures 10 and 11). The
calculated concentrations can also be viewed in the sample details report
(Section IX.F).

4. Repeat Step 1 with any other desired set of standards and samples.
Notes:

1. Asecond standard curve can be created using a different set of samples.
Repeat Step 1 using the new set of standard samples. Multiple standard
curves may be created within the same data set if none of the samples and
standards are shared.

If you attempt to generate an additional standard curve using samples that
are used in the current standard curve, the alert box “Confirm Standard
Curve Replace” will appear. The currently assigned standard curve will be
overwritten with the new standard curve if “OK” is selected.

2. Anexisting standard curve can be changed or additional unknowns added.
To do so, delete the existing standard curve. Go to the “Standard Curves”
tab, then select “Remove Standard Curve”. The “Remove Standard Curve”
button is only active in the “Standard Curves” tab.

E Remove Standard Curve.
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Figure 10. The Standard Curves tab. A standard curve with the log concentration on the Y axis and
the cycle threshold on the X axis.
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Figure 11. The Standard Curve tab. A standard curve with the cycle threshold on the Y axis and the
log of the concentration on the X axis.

Note: Samples that do not cross the amplification threshold, such as the no-template
controls, are listed in the graph as not having a valid C, value.
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O IX.F. Reports

The Plexor™ Analysis Software includes five report options: “Sample Details”,
l’rmega “Thresholds”, “Baseline Regions”, “Run Info” and “Import Files”, which are included
as subtabs in the “Reports” tab. To view these report options, select the “Reports”
tab. Information is presented in a tabular format that can be copied, saved or printed
using the provided icons. The saved data can be opened using Microsoft® Excel.

For multiplex assays, the Plexor™ Analysis Software reports include information for
all of the dye labels.

Sample Details: The sample details report includes well location, sample ID, dye
channel, cycle threshold, thermal melt temperature, concentration (if applicable),
whether the sample has the expected T, and the number of melt curves that cross
the melt threshold line (Figure 12).

A sample with a C, value of “N/A” has an amplification curve that did not cross the
amplification threshold.

PR Curas| Sampia (0s| Standard Camas Roports |
Sample Dutais | raesnasts| Gareting Regions]| Runinte | impar fites|

o Tm
[ns 3 148
pa EREEE
laz 7|_raa
= ma_ra7)

a_ TAd

IE

HEELUEHE

HEBEHEEE
o

5055TA

[EE T
Figure 12. The Sample Details tab.

Thresholds: The thresholds report includes the numerical values for the thresholds in
the current analysis (Figure 13). This information can be used to develop an analysis
template for assays where the same or similar thresholds will be used on a routine
basis. See Section X.C for more information about creating an analysis template.
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Figure 13. The Thresholds tab.
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Baseline Regions: The baseline regions report includes the numerical values for the
cycle number used in each sample (Figure 14).

Run Info: The run info report includes the information from the data import Pfomega
(Figure 15).

Import Files: The Import Files report includes information on the data import files

(Figure 16).
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Figure 15. The Run Info tab.
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Figure 16. The Import Files tab.

Promega Corporation 2800 Woods Hollow Road -Madison, WI 53711-5399 USA -Toll Free in USA 800-356-9526 - Phone 608-274-4330 -Fax 608-277-2516 -www.promega.com
Printed in USA. Part# TM290
5/07 Page 45



O IX.G. Saving and Printing the Analysis File

1. The Plexor™ Analysis Software saves the analysis as an *.aan file. The
l’romega current analysis can be saved at any time by selecting “Save Analysis File

(-aan)” in the “File” menu.

2. Selected wells can be exported into a new analysis file. In the “File” menu,
select “Export Selected Wells as New Analysis File (*.aan)”.

3. The analysis screen can be printed or saved as a screenshot. In the “File”
menu, select “Save a Screenshot (.png)” or “Print a Screenshot”.

4. A Run Template and Analysis Template from an existing analysis can be
exported and used in future analyses (Section XI.C).

X.  Troubleshooting

Symptoms Causes and Comments

Flat amplification curve in the Be sure that the reactions were assembled correctly. See the
amplification curves window Technical Manual supplied with the Plexor™ Systems.

(no apparent amplification) Template was degraded or of insufficient quantity. Verify the

integrity of the DNA or RNA template by electrophoresis.
Repeat the DNA or RNA purification if necessary. Add
RNasin® Ribonuclease Inhibitor to the reaction to inhibit a
broad spectrum of RNases.

Amplification inhibitor was present in the DNA or RNA
template. Reduce the volume of template in the reaction.
Repeat the DNA or RNA purification if necessary. Add the
template in question to the positive control reaction. A
significant increase in the C, value or no amplification in the
positive control reaction indicates the presence of inhibitors in
the template.

Thermal cycler was programmed incorrectly. Verify cycle times
and temperatures (Section IV, V or VI).

Data collection settings were incorrect. Data collection must
occur during the extension step. The extension time must be
sufficient for data collection. Verify the data collection settings.
The wrong dye or detector was selected, or the dye was
incompatible with the instrument. Be sure the selected
detectors are appropriate for the fluorescent dyes used.

The Plexor™ Master Mix may have lost activity. Be sure to
store the Plexor™ qPCR and qRT-PCR Systems at -20°C to
avoid loss of enzyme activity. Confirm the instrument
settings, and perform a positive control reaction to determine
if there is a problem with the Plexor™ System reagents.

The primer sequence was incorrect. Verify the primer
sequence.

Poor primer design. Redesign primers, targeting a different
region of the gene of interest. We strongly recommend using
the Plexor™ Primer Design Software, which is available at:
WWww.promega.com/plexorresources/
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X.  Troubleshooting (continued) O

Symptoms Causes and Comments
Flat amplification curve in the Primer was degraded. Use MOPS/EDTA Buffer to resuspend l,romega
amplification curves window and dilute primers. Iso-dC-containing primers are sensitive to
(no apparent amplification) pH. Rehydrating or storing the primer in water or a buffer
(continued) with a pH less than 7.0 will result in primer degradation. Do
not use water to resuspend or dilute primers or make primer
mixes.
Primers may have been synthesized incorrectly. Resynthesize
primers.

Primer concentration was incorrect. Verify the primer
concentration by measuring the absorbance at 260nm.
The scale of the Y axis was inappropriate. If the scale of the
Y axis is too broad, the change in fluorescence may not be
visible. Adjust the scale of the Y axis.

Increasing fluorescence over time Excessive template was added to the reactions. Dilute the
template and re-amplify.
The baseline region was set in a region with significant
fluorescence fluctuation. The baseline within the baseline
region should be flat. Manually adjust the baseline region
(Section XLD).
The baseline region was set too close to the signal change.
Manually adjust the baseline region (Section XI.D).

Two or more distinct melt curvesin  For the Plexor™ gRT-PCR Systems, both RNA and DNA

the melt curves window templates can be amplified. Treat the RNA template with
DNase to eliminate contaminating genomic DNA.
Poor primer specificity. Design new primers with higher
specificity to the target. To verify primer specificity, perform a
BLAST search with the primer sequence. The primer should
not exhibit regions of identity with other sequences.
Optimize the annealing temperature. Increase the annealing
temperature by increments of 2°C to reduce the synthesis of
primer-dimers or nonspecific amplification products.
Pseudogenes or polymorphic genes may exist. Design new
primers to avoid regions of identity between gene family
members.
Assemble the reactions on ice to minimize the synthesis of
primer-dimers or nonspecific amplification product.
Reduce the number of amplification cycles to minimize the
synthesis of primer-dimers or nonspecific product.
Check for signal bleedthrough. Calibrate the instrument as
instructed by the manufacturer for the dye set used.
Decrease the primer concentration (e.g., 0.1pM).
Primer pairs in a multiplex reaction can interact to form
undesired amplification products. Perform a BLAST search to
reveal regions of identity with undesirable target sequences.
Label the primer with the lowest homology to other sequences.
Alternatively, design new primers using the Plexor™ Primer
Design Software, which is available at:
WwWw.promega.com/plexorresources/
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O X.  Troubleshooting (continued)

Symptoms Causes and Comments
l’rmega Broad melt curve or a shoulder on ~ Pseudogenes and polymorphic genes may exist. Perform a
the melt curve BLAST search of the target sequence. When designing

primers, choose target sequences that have the fewest regions
of identity with pseudogenes and polymorphic genes.
Check for signal bleedthrough. Calibrate the instrument as
instructed in Section III or per manufacturer instructions.
Decrease the primer concentration (e.g., 0.1pM).

Be sure the thermal cycler was programmed correctly

(Section IV, V or VI).
No melt curve observed in the Poor amplification. See causes and comments for “Flat
melt curve window amplification curve in the amplification curves window

(no apparent amplification)” above.
Problems with data export or instrument analysis have
occurred. Review the instructions for data export and
instrument setup.
Data collection settings were incorrect. Verify the thermal
cycling program and data collection settings are correct
(Section IV, V or VI).
Incorrect files were imported. Be sure to import the proper
files containing related amplification data and dissociation data.
Instrument was programmed incorrectly. Verify the thermal
cycling program is correct (Section IV, V or VI).
Variability in signal among Calibrate your pipettes to minimize variability in pipetting.
replicate samples

Small volumes are difficult to pipet accurately. Do not pipet
volumes <1pl; dilute the template, so larger volumes are
pipetted.

Some variation is normal. A difference of 1-2 cycles for the C;
values is within the normal variation associated with an
exponential amplification reaction.

There will be statistical variation in the amount of template in
a reaction with targets present at low copy number. Poisson
distribution predicts difficulty associated with reliable detection
of very dilute samples with few target molecules.

Mixing was inadequate. Vortex reagents to mix well prior to
pipetting.

Use reaction plates recommended by the instrument
manufacturer.

Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer.

Thermal cycling conditions were suboptimal. Optimize the
annealing temperature.

Thermal cycling conditions were suboptimal. Redesign your
primers, so the melting temperatures are 60°C. We strongly
encourage using the Plexor™ Primer Design Software.
Viscous samples (e.g., high-molecular-weight genomic DNA)
are difficult to pipet accurately. Dilute the DNA template.
Shear high-molecular-weight DNA by vortexing or pipetting.
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X.  Troubleshooting (continued) O

Symptoms Causes and Comments
Variability in signal among The baseline region was not set correctly. The baseline should mmega
replicate samples (continued) be flat. The baseline region can be adjusted manually for each

well to account for sample-to-sample variation (Section XL.D).
Be sure the reaction plates are properly sealed to avoid

evaporation.
Fluorescence decrease observed in  Nonspecific product can accumulate at higher cycle number in
the no-template control reactions with targets present at low copy numbers. Assemble

the reactions on ice to reduce the accumulation of nonspecific
amplification products.

Decrease the cycle number to reduce the accumulation of
nonspecific amplification products.

Design new primers using the Plexor™ Primer Design
Software.

Reactions were contaminated with target DNA or RNA. Clean
workstations and pipettes with a mild bleach solution before
and after use. Use new reagents and solutions. Take
precautions to prevent contamination (see the Plexor™ gPCR
System Technical Manual #TM262, the Plexor™ One-Step
qRT-PCR System Technical Manual #TM263 or the Plexor™
Two-Step qRT-PCR System Technical Manual #TM264).

An improperly calibrated instrument can lead to erratic
fluorescence readings. Calibrate the instrument as instructed
in Section III or per manufacturer instructions.

Vertical fluorescence spikes or Consult the instrument manufacturer’s user’s manual for
significant “noise” in the information about potential instrument problems that can
amplification curve cause spikes or noise.

No amplification or poor amplification for the entire run.
Poor amplification can lead to improper data scaling, making
the fluorescence measurements appear erratic. See possible
causes and comments for “Flat amplification curve in the
amplification curves window (no apparent amplification)”
above.

Instrument was improperly calibrated. Calibrate instrument
as instructed in Section III or per manufacturer instructions.

Small signal change in No amplification or poor amplification. See causes and

amplification curve and melt comments for “Flat amplification curve in the amplification

curves curves window (no apparent amplification)” above.
Incorrect filter was selected. Verify the presence of the
appropriate filter.

Primer concentration was incorrect. Verify primer
concentration by measuring the absorbance at 260nm.

The scale of the Y axis of the amplification curve was affected
by other reactions on the plate. A high fluorescent signal for
one or more reactions can cause the scale of the Y axis of the
amplification curve to be too high to see changes in some data.
Adjust the scale of the Y axis to accommodate samples with
smaller changes in fluorescence. See Section IX.C.
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O X.  Troubleshooting (continued)

Symptoms Causes and Comments
l’romega Nonlinear standard curve, An amplification inhibitor was present in the standard
low R? values reference template. Determine whether the template contains

inhibitors by adding the DNA template to the positive control
reaction; a significant increase in the C; value or no
amplification of the positive control in the presence of the
DNA template indicates the presence of inhibitors. Repeat
purification of the standard reference template used to
generate the standard curve.

Calibrate your pipettes to minimize variability in pipetting.
Small volumes are difficult to pipet accurately. Do not pipet
volumes <1pl; dilute the template, so larger volumes are
pipetted.

Viscous samples (e.g., high-molecular-weight genomic DNA)
are difficult to pipet accurately. Dilute the DNA template.
Shear high-molecular-weight DNA by vortexing or pipetting.
Adjust the baseline region. The baseline region can be
manually adjusted for each reaction. See Section XL.D.

Some variation is normal. Perform duplicate or triplicate
reactions for the standard curve to minimize the effect of this
variation.

There will be statistical variation in the amount of template in
a reaction with targets present at low copy number. Perform
duplicate or triplicate reactions for the standard curve.

An error was made during dilution of the standard reference
template. Verify all calculations, and repeat dilution of the
standard reference template. Do not pipet volumes <1pl.
Incorrect concentration values were entered in the Plexor™
Analysis Software. Verify the concentrations for all samples
used to generate the standard curve.

Reactions were contaminated with target DNA or RNA. Clean
workstations and pipettes with a mild bleach solution before
and after use. Use new reagents and solutions. Take
precautions to prevent contamination (see the Plexor™ gPCR
System Technical Manual #TM262, the Plexor™ One-Step
gRT-PCR System Technical Manual #TM263 or the Plexor™
Two-Step qRT-PCR System Technical Manual #TM264).
Carefully seal the reaction plate to avoid evaporation.
Aberrant fluorescence can be caused by contamination,
fingerprints, etc. Do not write on the surface of the optical
adhesive plate covers. Use caution when handling optical
adhesive plate covers. Wear gloves.
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X.  Troubleshooting (continued) O
Symptoms Causes and Comments l’romega

Slope less than 0.2 No amplification or poor amplification. See causes and
(inefficient amplification) comments for “Flat amplification curve in the amplification
curves window (no apparent amplification)” above.
Nonspecific amplification can become a problem in later
amplification cycles with samples containing small amounts of
target template. Decrease the number of amplification cycles.
Poor primer design. Design new primers.
Annealing temperature was too high. Design new primers
with melting temperatures of 60°C. We strongly recommend
using the Plexor™ Primer Design Software.
Annealing temperature was too high. Optimize the annealing

temperature.
Amplification in no-reverse Contaminating DNA sequences related to the RNA template
transcription control for the were present in the RNA preparation. Treat the RNA Plexor™
gRT-PCR Systems template with DNase to remove contaminating DNA.

Design new primers to span introns to avoid amplification of
contaminating genomic DNA.

Nonspecific amplification occurring in reactions that contain a
low number of copies of the template. Assemble reactions on
ice.

Decrease the number of amplification cycles to reduce
accumulation of nonspecific amplification products.

Design new primers to minimize the synthesis of nonspecific
amplification products.

Reactions were contaminated with target DNA or RNA. Clean
pipettes and workstations with a mild bleach solution before
and after use. Use new reagents and solutions. Use positive-
displacement pipettes or aerosol-resistant tips to reduce cross-
contamination during pipetting. Use a separate work area and
pipettes for pre- and postamplification. Wear gloves, and

change them often.
No amplification in the positive No amplification or poor amplification. See causes and
control reaction comments for “Flat amplification curve in the amplification

curves window (no apparent amplification)” above.

Verify that the thermal cycling program and data collection
settings are correct (Section IV, V or VI).

Instrument setup problems can cause amplifications to fail.
Consult the instrument manufacturer’s user’s manual for more
information about potential instrument problems.

The Plexor™ Master Mix may have lost activity. Be sure to
store the Plexor™ qPCR and gRT-PCR Systems at -20°C to
avoid loss of enzyme activity. Confirm the instrument
settings, and perform a positive control reaction to determine
if there is a problem with the Plexor™ System reagents.

The RNA template used in the Plexor™ qRT-PCR System was
contaminated with ribonuclease (RNase). Take precautions to
prevent RNase contamination. Clean workstations and pipettes
with a mild bleach solution before and after use. Use new
reagents and solutions.
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O X.

Symptoms

Troubleshooting (continued)

Causes and Comments

No amplification in the positive
control reaction (continued)

The RNA template used in the Plexor™ qRT-PCR Systems was
degraded. RNA storage conditions are very important. Store
RNA template at -70°C in single-use aliquots to minimize the
number of freeze-thaw cycles. Once thawed, keep RNA on ice.
Always use nuclease-free, commercially autoclaved reaction
tubes, sterile aerosol-resistant tips and gloves to minimize
RNase contamination.

Reactions were assembled incorrectly. Repeat the experiment,
and assemble reactions as described in the Plexor™ gPCR
System Technical Manual #TM262, the Plexor™ One-Step
gRT-PCR System Technical Manual #TM263 or the Plexor™
Two-Step qRT-PCR System Technical Manual #TM264.

Unable to import data. An error
like “Expecting NEWLINE,
found”” or “Unexpected Token
Error” is encountered

The data has been altered after export from the real-time PCR
instrument software. Any alteration of this data is likely to
change the formatting and can cause import errors. Do not
open the exported files with other software programs.

Software appears abnormal
(the screen appears compressed,
lines are replaced with dots, etc.)

Data display in the Plexor™ Analysis

Be sure that the display settings for the computer are set to
32-bit color, rather than 16-bit color, when using the Plexor™
Analysis Software.

Genotyping: Miscalled known
heterozygous samples: Product
formed with only one of the two
genotyping primers

Poor primer design. Redesign primers. We strongly recommend
using the Plexor™ Primer Design Software, which is available
at: www.promega.com/plexorresources/

The annealing temperature was too high or too low. Optimize
the annealing temperature.

Genotyping: Miscalled known
homozygous samples: Product
formed (signal decrease) with
both primers

Poor primer design. Redesign your primers. We strongly
recommend using the Plexor™ Primer Design Software, which
is available at: www.promega.com/plexorresources/

The annealing temperature was too high or too low. Optimize
the annealing temperature.

Genotyping: Miscalled known
homozygous samples: Product
formed only with the mismatched
primer but not with the matching
primer

The primer sequence was incorrect. Verify that the primer
sequence is correct.

Genotyping primer #1 and primer #2 were switched. Verify
that the correct primer was used.

Genotyping: No call

Add more template.
Redesign primers.
See comments for “Flat Amplification Curve.”
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XL. Appendix O

XLA. Plexor™ Analysis Software Operating System Compatibility

The Plexor™ Analysis Software is compatible with the following operating systems:
Windows® 98, Windows NT® 4, Windows® ME, Windows® XP and Windows® 2000.
Other operating systems are not supported. The Plexor™ Analysis Software is not
compatible with Macintosh® computers.

Be sure that the display settings for the computer are set to 32-bit color, rather than
16-bit color, when using the Plexor™ Analysis Software.

XLB. Plexor™ Analysis Software Installation

The Plexor™ Analysis Software and installation instructions are available for
download at: www.promega.com/plexorresources/. The software is also available
free-of-charge on CD-ROM by request. Consult the Promega Web site to verify that
you are installing the most recent version of the software. Following installation, the
program can be accessed in the “Start” menu: Programs'\ Plexor\ Analysis Desktop.

Instructions for Installing the Plexor™ Analysis Software from CD-ROM

1.  Insert the CD-ROM into the CD-ROM drive.

2. Double-click the “Plexor.exe” installer icon on the CD-ROM, and follow
the on-screen instructions to install the software.
Note: Installation of the software may take several minutes. There is a
pause where the computer may appear to be inactive between the launch
of the installer and the software installation.

XI.C. Advanced Options

At the “File Import” screen, Step 3 (Figure 3), there are two “Advanced Options”
buttons: “Run Template” and “Analysis Template”. These options allow plate
configuration and assay parameter information to be saved for reuse during routine
experiments.

Run Template: A run template is used to assign sample types, sample colors and
concentrations of standards (Figure 17). If you routinely use the same setup for
plates of standard samples and unknowns, a run template can be created, stored
and applied to subsequent runs.

1. Select “Run Template”.

2. Assign colors, sample types and concentrations to the standards in the
“Plate Setup” tab.

3. Use the “Sample IDs” tab to label your samples. Simply select the sample
you wish to name and start typing.

4. Select “Export” to save the plate configuration to a *.rtp file for later use.

5. Select “OK”.

To import an existing *.rtp file that contains a saved plate configuration, select
“Import” and browse to that file.
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Setthe sample types, colors, target concentrations, and sample ID's for each sample using the well
seleclor below.
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Figure 17. A Run Template.

Analysis Template and Definition of Analysis Functions: The analysis template is
used to optimize the analysis settings for the experiment. If you routinely perform
reactions with the same analysis conditions, an analysis template can be created,
stored and applied to subsequent runs. These settings can be exported as a *ntp file,
then imported for subsequent experiments. A description of the functions for each
setting follows.

1. Select “Analysis Template”.

2. Enter the desired values for the analysis defaults for each dye used
(Figure 18).
Note: Descriptions of the analysis details are provided below.

3. Select “Export” to save the default settings to a *.ntp file for later use.

4. Select “OK”.

To import an existing *ntp file that contains the saved default settings, select
“Import” and browse to that file.

Default Amplification Threshold (RFU) Baseline Noise Standard Deviations: The
Plexor™ Analysis Software has a user-definable amplification threshold that
determines the RFU value at which sample cycle thresholds are called.

This value is based on the variation (noise) in the baseline regions of all samples and
is determined by taking the mean and standard deviation of all RFUs in baseline
regions. The threshold is set a specified number of standard deviations below the
mean. The default threshold is 10 standard deviations but can be changed in the
Analysis Template or recalculated at any time by using “Set Amp Threshold from
Selected Samples” option in the “Edit” menu (See Section IX.D).
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Analysis Defaults p— |

Set the default parameters for analyzing the targets in this assay. | l,romega

Analysis Details '
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Default Melt Threshold (-d(RFUYdT) Percentage (0.0 - 100.0%): I25.0

Expactad Target Malt Temperaturs (Tm) (85.0 - 95.0°C): [90.0 |

5061TA

Figure 18. The Analysis Defaults tab.

Default Melt Threshold -d(RFU)/dT Percentage: The melt curve allows you to
distinguish amplification products with different sequences and lengths. In the
absence of nonspecific amplification products, the melt curve will have one peak.
Each sample has a melt curve, from which a T, can be determined. A T, value is
reported for all melt curves that cross the melt threshold. The melt threshold
represents the -d(RFU)/dT value that is required before a T,, value is reported for
a sample. A sample’s T, value is calculated as the temperature at which the melt
curve has the lowest (i.e., the most negative) -d(RFU)/dT value.

The default melt threshold -d(RFU)/dT percentage is preset at 25.0% and can be set
between 0.0 and 100.0%. This value is used by the software to calculate the melt
threshold value. The T, threshold value is defined as a percent of the -d(RFU)/dT
value for the sample with the lowest -d(RFU)/dT value in the data set.

The melt threshold value is recalculated when a standard curve is generated. The
melt threshold value can be manually adjusted by clicking and dragging the
horizontal melt threshold line.

Expected Target Melt Temperature: The expected target melt temperature is the melt
temperature of the correct PCR product. The expected target melt temperature must
be between 65°C and 95°C. The default expected target melt temperature is 90°C.

Target T,, Upper Bound: The target T,, upper bound is the number of degrees
Celsius above the expected target melt temperature at which a sample T,,, is
considered to be suspect. The default target T, upper bound is +1°C.

Target T,, Lower Bound: The target T,, lower bound is the number of degrees
Celsius below the expected target melt temperature at which a sample T, is
considered to be suspect. The default target T, lower bound is -1°C.
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O XL.D. Manual Baseline Adjustments

The proper baseline region is important for optimal analysis of Plexor™ System

l’romega data. Baseline regions are automatically determined during import of data into the
Plexor™ Analysis Software.

The baseline region is set in a flat region of the amplification curve before the
beginning of the downward inflection that indicates product accumulation. In some
instances, manual adjustment may provide optimal representation of the data. This
may include samples with excessive noise, bleedthrough or early C; values or
situations where the real time instrument shows early signal fluctuation.

1. Select the “PCR Curves” tab.
2. Select the “Display and Manually Adjust Baselines” icon: ﬁ(

3. Select the samples to be adjusted using the well selector.

Note: The baseline region can be adjusted for individual samples or
groups of samples by selecting or dragging the lower and upper limits.
The shading in the baseline region will be gray if the selected samples do
not share a common baseline region (Figure 19). For multiplex assays, the
baseline is set independently for each dye.

PER Curves | Sampie t0a] Cor 2000 £ | Rupers] Baseline
FAM - Targel 1 | JOE - Tan 2 H
} AR} / region e
| | [ Kamaple & ELE N Ve 1
:; § "..____ s
(120 [26.3)
. 0o 20 x  20 N\ % MR
=
—_ . g
Lower limit - Upper limit 2

Figure 19. An amplification window showing the baseline region and baseline upper and lower
limits.

4. Adjust the upper limit of the baseline region for each sample, so the upper
limit is approximately 5 cycles before the decrease in fluorescence and in
an area where the baseline is flat. The C, values for selected samples are
displayed in the table to the right of the graph. The C; value may change
when the limits are changed. See Notes 1 and 2.

5. If necessary, adjust the lower limit to a region that creates the flattest
baseline given the selected upper limit.

6.  Optional: The amplification threshold is based on noise within the
baseline region for all of the samples. When manual baseline adjustments
are complete, consider recalculating the amplification threshold for all
samples. Select all samples, and in the “Edit” menu, select “Set Amp
Threshold from Selected Samples” (Section IX.D ). See Notes 3 and 4.
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Notes: O
1. A maximum upper limit of 35 cycles can be used for samples without a C;

value (e.g., no-template control). l’romega

2. Samples with similar C, values can be adjusted simultaneously by
highlighting multiple wells.

3. The baselines for all samples can be reset to the automatic setting by
selecting the “Reset Baselines and Amp Thresholds” icon: m

4. To reset the baselines for a selected set of samples, select the samples in
the well selector, and in the “Edit” menu, select “Set Baselines for Selected
Samples”.

XLE. Icon Definitions
Assign Color (shortcut =“q")

The “Assign Color” function allows you to select a color in which a sample is
displayed. This color selection is associated with those samples in the amplification
and melt curves, well selector and any reports. Select one or more capillaries using
the well selector, then select this button to choose the desired color for the selected
samples. These colors are not transferred to printed copies or exported reports.
Sample color does not change the analysis of a sample in any way.

|E| Assign Unknown (shortcut = “w”)

The “Assign Unknown” function allows you to assign the sample type “unknown”
to all selected samples. Select one or more capillaries using the well selector, then
select this button to assign the sample type “unknown”. Unknown samples are
displayed as open squares in the well selector. They are labeled “unknown” in
reports. When included in a standard curve, the concentrations of unknown samples
will be calculated and reported.

@ Assign NTC (shortcut = “e”)

The “Assign NTC” function allows you to assign the sample type “no-template
control" to all selected samples. Select one or more capillaries using the well selector,
then select this button to assign the sample type “no-template control”. No-template
control reactions are displayed as diamonds in the well selector. They are labeled as
“no-template control” in reports. When included in a standard curve, the
concentrations of sample in the no-template control will be calculated and reported.

Assign Positive Control (shortcut = “t”)

The “Assign Positive Control” function allows you to assign the sample type
“positive control” to all selected samples. Select one or more capillaries using the
well selector, then select this button to assign the sample type “positive control”.
Positive control samples are displayed as hexagons in the well selector. They are
labeled “positive control” in reports. When included in a standard curve, the
concentrations of positive control samples will be calculated and reported.
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O Assign Standard (shortcut = “1”)

P The “Assign Standard” function allows you to assign the sample type “standard” to

all selected samples. Select one or more capillaries using the well selector, then
select this button to assign the sample type “standard”. Only samples that have
been assigned a type of “standard” will be used to generate the best-fit line in
standard curves. All standard samples must be assigned a concentration by the user
when they are defined as a standard. Concentrations may be entered in standard
format (0.01, 0.1, 1, 10, 100, 1000, etc.) or scientific format (le-2, le-1, 1e0, 1el, 1e2,
1e3, etc.). The software does not accept commas in the concentration assignments.
Standard samples are displayed as circles in the well selector and standard curve
graphs. They are labeled “standard” in reports.

$i%: | Create Dilution Series (shortcut = “f”)

The “Create Dilution Series” function creates a full dilution series within a row or
column of capillaries. Select the capillaries that contain a dilution series of the
standard, then select “Create Dilution Series”. You must enter the initial
concentration of the series, the dilution factor and whether the series is increasing or
decreasing (Figure 14). Concentrations may be entered in standard format (0.01, 0.1,
1,10, 100, 1000, etc.) or scientific format (1e-2, le-1, 1e0, 1el, 1e2, 1e3, etc.). The
software does not accept commas in the concentration assignments.

All selected capillaries will be assigned the sample type “standard” with the
appropriate concentration. This function can only be performed with standards
within the same row or column. Using this function produces the same result as
selecting each capillary in the series individually and assigning it the sample type
“standard” with the appropriate concentration. Only samples that have been
assigned the sample type “standard” will be used to generate the best-fit line in
standard curves. Standard samples are displayed as circles. A row or column of
capillaries within a dilution series of standards may be assigned as standards
simultaneously by highlighting multiple capillaries and using the “Create
Dilution Series” function.

L\_{ Add Standard Curve (shortcut = “d”)

The “Add Standard Curve” function fits the experimentally measured C; values and
user-entered concentration values for standard samples to a straight line using the
least mean squares method. It will calculate the concentrations of unknown samples,
positive control reactions and no-template control reactions from their measured C,
values using the equation for the best-fit line. Any sample with a concentration of
“N/A” on the report or elsewhere did not cross the cycle threshold, so the
concentration of that sample cannot be calculated.

Select all of the samples you wish to use as standard samples, as well as all other
samples for which you wish to calculate concentrations. Choose “Add Standard
Curve” from the “Edit” menu. Type “d” or select the “Add Standard Curve” icon on
the toolbar.

You may create as many standard curves as you wish for a single set of data, but no
sample can be used to generate more than one standard curve. It is not possible to
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add samples to an existing standard curve, but a new curve can easily be
constructed with a new selection. This action will remove the existing standard
curve and generate the new standard curve using the samples you have selected.

You may generate the original standard curve at any time. l,romega

tb: Remove Standard Curve (shortcut = “c”)

The “Remove Standard Curve” function removes the standard curve on the tab that
is currently selected. This function is only available in the “Standard Curves” tab.

ﬁ;t Display and Manually Adjust Baselines

The “Display and Manually Adjust Baselines” function allows you to set the
baseline range for a sample or set of samples. Select one or more wells using the
well selector, then select this button. See Section XI.D.

ﬁ( Reset Baselines and Amp Thresholds

The “Reset Baselines and Amp Thresholds” function allows you to reset the baseline
range and amplification threshold for all samples. See Section XI.D.

XLF. Amplification Efficiency Calculations

The Plexor™ Analysis Software automatically calculates the equation for the best-fit
line and determines the R? value of the standard curve. The R? value is a measure of
the fit of the data points to a straight line. An R? value of 1.0 is a perfect fit. R values
should be close to 1.0.

The software also calculates the slope of the standard curve. The slope is an indication
of the efficiency of the PCR. At 100% efficiency, the amount of amplification product
doubles with every cycle, so C; values differ by 1 for each twofold dilution of the
template. At 100% efficiency, the amount of product increases tenfold every 3.32 cycles
(2332 =10), so C, values differ by 3.32 for each tenfold dilution. A reaction with 100%
efficiency will have a slope of -3.32 when the amplification curve is displayed with
the C, values on the Y axis and log concentration on the X axis. When the
amplification curve is displayed as C; versus log concentration, the efficiency may
be calculated as [(10-1/slope) -1] x 100% (1).

XI.G. Reference

1. Bustin, S.A. (2004) A-Z of quantitative PCR. International University Line, La Jolla
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@Patents for the foundational PCR process, European Pat. Nos. 201,184 and 200,362, expired
on March 28, 2006. In the U.S,, the patents covering the foundational PCR process expired on
March 29, 2005.

®The purchase of this product conveys to the buyer the limited, nonexclusive, nontransferable
right (without the right to resell, repackage, or further sublicense) under U.S. Published Patent
Appln. 20020150900 and U.S. Pat. Nos. 5,432,272, 6,617,106 and 6,140,496 to use the product. No
other license is granted to the buyer whether expressly, by implication, by estoppel or
otherwise. In particular, the purchase of this product does not include or carry any right or
license to sell this product. For information on purchasing a license for other uses, please
contact Promega Corporation, Licensing, 2800 Woods Hollow Road, Madison, WI 53711, or
EraGen Biosciences, Corporate Licensing, 918 Deming Way, Suite 201, Madison, W1 53717.
Phone (608) 662-9000; Fax (608) 662-9003.

(©This product is designed and sold for use in the multiplex PCR process covered by U.S. Pat.
No. 5,582,989 and Canadian Pat. No. 1,339,731. A limited license has been granted under the
patent to use only this amount of the product to practice the multiplex PCR process and is
conveyed to the purchaser by the purchase of this product.

© 2007 Promega Corporation. All Rights Reserved.

RNasin is a registered trademark of Promega Corporation. ImProm-II and Plexor are
trademarks of Promega Corporation.

LightCycler is a registered trademark of Roche Diagnostics, GmbH. Macintosh is a registered
trademark of Apple Computer, Inc. Microsoft, Windows and Windows NT are registered

trademarks of Microsoft Corporation.

Products may be covered by pending or issued patents or may have certain limitations. Please
visit our Web site for more information.

All prices and specifications are subject to change without prior notice.

Product claims are subject to change. Please contact Promega Technical Services or access the
Promega online catalog for the most up-to-date information on Promega products.
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